Microsoft Publisher
Project 2 – Designing a Newsletter

Introduction
Desktop publishing implies doing everything from a desk, including the planning, designing, writing, and layout, as well as printing, collating, and distributing. You can create a professional publication from your computer without the cost and time of sending it to a professional publisher.

Newsletters are a popular way for offices, businesses, schools, and other organizations to distribute information to their clientele. A newsletter usually is a double-sided multipage publication with newspaper features, such as columns and a masthead, and the added eye appeal of sidebars, pictures, and other graphics.

Advantages
- Typically cheaper to produce than brochures
- Narrower and more focused in scope than newspapers; eye appeal is more distinctive
- Perfect for information that might be rapidly dated

Objectives
- Select a template with font and color schemes, and specify page layout
- Type articles from scratch and import other articles from files
- Import graphics from files and Publisher Clip Art
- Proof the newsletter, with spell checking and the Design Checker
- Save the newsletter and print (double-sided)
Using a Newsletter Template

The Publisher newsletter templates include a four-page layout with stories, graphics, sidebars, and other elements typical of newsletters using a rich collection of intuitive design, layout, typography, and graphics tools. Using a template takes care of many design issues, resulting in few chances of publication errors.

To Start Publisher

1. Click the Start button on the Windows taskbar to display the Start menu.
2. Click All Programs at the bottom of the left pane on the Start menu to display the All Programs list.
3. Click Microsoft Office in the All Programs list to display the Microsoft Office list.
4. Click Microsoft Publisher to start Publisher.

To Choose a Newsletter Template and Change Options

The following steps choose a newsletter template and make design choices. The Watermark template goes along with the theme of the aquarium, as does the Tropics color scheme.

1. Click the Newsletters button in the list of publication types to display the catalog of newsletter templates.
2. Scroll until you see the Watermark template and then click it.
3. In the Customize area, choose the Tropics color scheme and the Foundry font scheme.
4. Click the Create button to create the publication and begin editing the template.

To Display Formatting Marks

If you wish to display Formatting Marks, you can at this time by clicking the Special Characters button on the Standard toolbar.
To Set Page Options
Typically, Publisher newsletters display story text in 1, 2, or 3 columns or in a mixed format. The aquarium newsletter will use the mixed format to complement the variety of articles that will be presented each month in the newsletter.
1. Click Page Options in the Format Publication task pane.
2. Click Mixed in the Columns area to choose a mixed number of columns for the various stories in the newsletter.

Editing the Newsletter Template
The purpose of a newsletter is to communicate and educate its readers. Publisher places the lead story in a prominent position on the page and uses a discussion of purpose and audience as the default text. Each Publisher newsletter template creates four pages of text and graphics; however, not all newsletters require four pages. You can use the Page Sorter to delete or rearrange pages.

To Change and Delete Pages in a Newsletter
1. Click the Page 2 icon on the page sorter to display page 2.
2. Right-click the Page 2 icon to display the shortcut menu.
3. Click Delete Page to display the Delete Page dialog box. If necessary, click the Both pages option button.
4. Click the OK button in the Delete Page dialog box.
**Editing the Masthead**
Most newsletters and brochures contain a masthead similar to those used in newspapers. A *masthead* is a box or section printed in each issue that lists information, such as name, publisher, location, volume, and date.

**To Edit the Masthead**
1. Click the Page 1 icon on the page sorter to display page 1. Click the text, Newsletter Title, to select it. Zoom in, if necessary.
2. Type **Communiquarium** to replace the text.
3. Select the placeholder text in the Business name text box by clicking the textbox and press CTRL + A to select all of the text.
4. Type **A monthly newsletter of the Riverside Aquarium** to replace the text.
5. Click the text in the Newsletter Date text box.
6. Type May 1, 2008 to replace the text.

![Image of masthead being edited](image)

**Newsletter Text**
You will import some stories for the newsletter; others you will type yourself. Publisher allows users to import text and graphics from many sources, from a variety of different programs, and in many different file formats. **Importing** is inserting text or objects from any other source into Publisher workspace. Publisher uses the term, **story**, to mean text that is contained within a single text box or a chain of linked text boxes. Each newsletter template provides **linked text boxes**, or text boxes whose text flows from one to another. In the templates, two or three text boxes may be linked automatically; however, if a story is too long to fit in the linked text boxes, Publisher will offer to link even more text boxes for easy reading.

Publisher suggests that 175 to 225 words will fit in the space allocated for the lead story. The story displays in a two-column text box that connects, or wraps, the running text from one linked text box to the next. This newsletter has three stories, two of which have been typed in Microsoft Word. The third story you will have to type yourself. Each story will include a headline, which is a short phrase printed at the top of a story, usually in a bigger font than the story. A **headline** summarizes the story that follows.
To Edit a Headline and Import a Text File
1. Click, Lead Store Headline, to select it. If necessary, Zoom in.
2. Type Riverside Aquarium Opens Its Doors to replace the text.
3. Click the story below the headline.
4. Click Insert on the menu bar.
5. Click Text File to display the Insert Text dialog box.
6. Navigate to the document Riverside Aquarium Opens Its Doors and double-click it. The article should be inserted.

Continuing a story across columns or text boxes is one of the features that Publisher helps you to perform. If the story contains more text than will fit in the default text box, Publisher displays a message to warn you. You then have the option to allow Publisher to connect or autoflow the text to another available text box, or to flow the text yourself. If you allow Publisher to flow the text, you then can format the text boxes with continued notices, or jump lines, to guide the readers through the story.
To Import Text for the Secondary Story and Continue It on Page 2

1. Scroll to display the lower portion of page 1 and then click the Secondary Story Headline placeholder.
2. Type **National Accreditation Award** to replace the selected text.
3. Click the text in the secondary story.
4. Click Insert on the menu bar and then click Text File.
5. Navigate to locate the file, National Accreditation Award, and double-click it to insert it in the publication.
6. Publisher will display a dialog box asking if you want to use autoflow.
7. Click the Yes button to flow text. Publisher will display a second dialog box asking if you want to flow text into the selected box at the top of page 2.
8. Click the No button to cause Publisher to move to the back page story and display another dialog box about autoflowing.
9. Click the Yes button to autoflow into the back page story.
To Format with Continued Notices
1. Move to page 1.
2. Double-click the border of the lower right text box. When Publisher displays the Format Text Box dialog box, click the Text Box tab.
3. Ensure that Include a “Continued on page...” has a check mark in the check box.
4. Click the OK button.
5. Double-click the border of the lower left text box. When Publisher displays the Format Text Box dialog box, click the Text Box tab.
6. Ensure that Include a “Continued from page...” has a check mark in the check box.
7. Click the OK button.

To Replace the Back Page Story Headline
1. Select the text, Back Page Story Headline.
2. Type Award to replace the text.

Editing Stories in Microsoft Word
So far you have edited text in Microsoft Publisher and imported text from a previously stored file. Another way to edit text is to use Microsoft Word. Publisher provides a link between the two applications. If you are changing a few words, stay in Publisher, but if you need to edit more, then edit the story in Word. If you are editing a story in Word, you cannot edit the corresponding text box in Publisher.

To Edit a Story Using Word
In this newsletter, the back page contains a text box to display more information or articles about the organization. The aquarium’s informational text has not been previously stored in a file for importing, so it must be typed...using Word.
1. Scroll to display the text box in the upper-right portion of page 2.
2. Select the placeholder text.
3. Click the Edit menu.
4. Click Edit Story in Microsoft Word command
5. When Microsoft Word starts, press CTRL+A to select all of the text.
6. Type **Join the fun!** and then press the ENTER key.
7. Type **Become a member!** and then press the ENTER key.
8. Type **If you enjoy Riverside Aquarium, and have yet to become a member, you are missing out on an incredible deal.** Aquarium membership allows year-round admission to Riverside and to more than 100 other U.S. zoos and aquariums. A family of four can enjoy the aquarium all year for only $50. In addition, members receive a 10 percent discount on programs and purchases from the gift shop. Each membership helps support Riverside Aquarium’s education programs and activities.
9. Press the ENTER key.
10. Type **To become a member, or to send a gift membership to someone special, visit our Web site at RiversideAquarium.org or call (850) 555-FISH.**
11. Click the Close button on the Title bar of the Document in Communiquarium Newsletter window to close it.
**To Change the Font Size**
1. Still working on page 2, upper-right placeholder.
2. Drag to select the first two paragraphs of text.
3. On the Formatting toolbar, click the text in the Font Size box to select it.
4. Type 14 and then press the ENTER key. Do not deselect the first two paragraphs of text.

**To Use the Color Scheme Colors**
1. With the first two lines of the story still select, click the Font Color button arrow on the Formatting toolbar.
2. Click the Accent 3 (Red) color to change the font color of the selected text.
3. Click outside the text box to deselect the text.

**To Delete the Logo and Edit Other Text Boxes on Page 2**
1. In the upper left porting of page 2, right-click the logo, and then click Delete Object on the shortcut menu.
2. Click the text in the Primary Business Address text box. Press CTRL + A to select all of the text. Type **Riverside Aquarium** and then press the ENTER key.
3. Type **1400 River Drive** and then press the ENTER key.
4. Type **Pensacola, FL 32503** to finish the address.
5. Click the text in the Phone text box. Press CTRL + A to select all of the text. Type **Phone: (850) 555-FISH** and then press the ENTER key.
6. Type **Fax: (850) 555-3470** and then press the ENTER key.
7. Type **E-mail: riverside@nzaa.com** to finish the phone and e-mail information.
8. Click the text in the business tag line text box. Press CTRL + A to select all of the text. Type **More than just fish!** to replace the default tag line text.
9. Right-click the text in the “We’re on the Web” attention getter text box and then click Delete Object on the shortcut menu.
Using Graphics in a Newsletter
Most graphic designers use an easy technique for deciding how many graphics are too many. They hold the publication at arm’s length and glance at it. Then, closing their eyes, they count the number of things they remember. If they remember more than five graphics that’s too many; two or fewer indicates too few. Graphics can make or break a publication. If graphics are used correctly they can enhance the text, attract the eye, and brighten the look of the publication.

Graphics are not limited to pictures and images. They also can include tables, charts, shapes, lines, boxes, borders, pull quotes, and sidebars. A side bar is a small piece of text, set off with a box or graphic, and placed beside an article. It contains text that is not vital to understanding the main text, but usually adds interest or additional information. Tables of contents, art boxes, and bulleted points are examples of side bars. A pull quote is an excerpt from the main article to highlight the ideas or to attract the readers and may be set off with a box or graphic.

Graphics can be imported from a file, just like stories.

To Replace a Graphic and Edit the Caption
1. On Page 1, click the graphic and then click it a second time.
2. Right-click the graphic to display the shortcut menu. On the shortcut menu point to Change picture and then choose From file.
3. Navigate to where the aquarium graphic is saved and then click Insert.
4. Select the text in the caption. Type New, world-class aquarium on the riverfront to replace the selected text.

To Replace a Graphic on Page 2 and Edit the Caption
1. On Page 2, select only the picture in the Award story.
2. Right-click the picture to display the shortcut menu. Point to Change Picture and then choose From File.
3. Navigate to where the handshake picture is saved and click Insert.
4. Select the text in the Caption and type Riverside Aquarium present accepts accreditation award to replace the text.

To Insert a New Picture from Clip Art
1. On Page 2, make sure you can see the upper half of the newsletter.
2. Click the Insert menu, point to Picture, and then choose Clip Art.
3. Type dolphin in the Search for box.
4. Scroll to find a picture of a dolphin similar to the one below and click it to insert it.
To Move and Resize a Graphic
1. If necessary, close the Clip Art task pane. With the graphic still selected, drag it to a location below the text box, as shown below. Point to the lower-right handle.
2. SHIFT + drag the handle until the graphic is approximately 2.5 inches wide, as measured by the horizontal ruler.

To Edit a Sidebar
1. Go to Page 1. Select the text Special points of interest and type Riverside has... to replace the text.
2. Select the bulleted list.
3. Type Later hours on weekends and press the ENTER key.
4. Type Special rates for school groups and press the ENTER key.
5. Type Discounts for senior citizens and press the ENTER key.
6. Type Adopt-a-sea-creature programs and press the ENTER key.
7. Type Petting tanks and press the ENTER key.
8. Type And much more! to complete the list.
To Delete the Sidebar
The other sidebar in the Watermark newsletter template is a table of contents. Because the newsletter now has only two pages, a table of contents is not necessary.
1. Scroll to display the Inside this issue sidebar on Page 1.
2. Right-click the text in the sidebar, and then click Delete Object. The blue colored rectangle should still be visible.

To Insert a Pull Quote
1. With the lower-left portion of Page 1 still displayed, click the Design Gallery Object button on the Objects toolbar.
2. When the Design Gallery window is displayed, click the Pull Quotes button in the list.
3. Scroll to and then click the Voyage preview.
4. Click the Insert Object button to insert the pull quote and close the Design Gallery window.
5. Drag the pull quote in front of the blue rounded rectangle.
6. Select the first sentence in the second paragraph of the National Accreditation Award story by dragging. Do not include the quotation mark at the beginning of the sentence.
7. Click the Copy button on the Standard toolbar. Click the placeholder text in the pull quote and click the Paste button on the Standard toolbar.
8. Click the Paste Options button to display its menu. Click the Keep Text Only command to maintain the pull quote’s formatting.
**To Finish Formatting the Pull Quote**

1. Click at the beginning of the quotation and then type a quotation mark to begin the quote.
2. Click at the end of the quotation. If necessary, press the backspace key to remove the space after the period. Type a quotation mark to end the quotation.
3. Press the ENTER key to move to the next line.
4. Type - - Ray Bishop to finish the pull quote.

**Moving Text**

To move text, you first select the text to be moved and then use drag-and-drop editing or the cut-and-paste technique to move the selected text. To use the drag-and-drop editing, you drag the selected item to the new location and then insert, or drop, it there. Using this method does not transfer data to the clipboard; neither does it cause Publisher to display the Paste Options button. Format changes to the text must be made manually.

When moving text between pages, use the cut-and-paste method. When moving text a long distance or between programs, use the Office Clipboard task pane to cut and paste. When moving text a short distance, the drag-and-drop method is more efficient.

**To Move Text**

1. Go to page 2. If necessary, scroll to display the story in the lower portion of the page.
2. Triple-click the paragraph that begins with the words, The board of accreditation noted, to select the paragraph.
3. Drag the selection to the destination location – before the previous paragraph – as shown below.
4. Release the mouse button to move the selected text to the location of the mouse pointer. To deselect the text, click the workspace.
Inserting Page Numbers
Page numbering on a two-page newsletter probably isn’t as necessary as it is for longer publications. Many readers reference articles and points by page numbers. Part of the design process is to provide a consistent look and feel to the layout and page numbers can provide a reference for the organization in designing future newsletters. Using page numbers in prominent locations, or using fancy fonts and colors can make page numbers a design element as well.

Headers and Footers
A header is text and graphics that print at the top of each page in a document. A footer is text and graphics that print at the bottom of each page.

To Insert Page Number in the Footer
1. Click Insert on the menu bar and then click Page Numbers.
2. Click the Position box arrow and then click the page number in the footer. Click the Alignment box arrow and then click Center to select the alignment within the footer.
3. Click the OK button to close the Page Numbers Dialog box.
4. Use the page sorter to move between page 1 and 2 and look at the change in page number.
5. Go to page 1 of the newsletter.

Checking the Newsletter for Errors
Before submitting a newsletter to a customer or printing service, you should proofread it. While proofreading, you look for grammatical errors and spelling errors. You want to be sure the layout, graphics, and stories make sense.

Spelling Errors
If a word is not in Publisher’s dictionary, it will be flagged with a red wavy underline. A flagged word is not necessarily misspelled, as many names, abbreviations, and specialized terms are not in Publisher’s main dictionary. If this happens, instruct Publisher to ignore the flagged word. To display a list of suggested corrections for a flagged word, right-click it, and then click a replacement word on the shortcut menu.

To Check the Newsletter for Spelling Errors
The Spelling command is accessed through the Tools menu or from the Standard toolbar.

1. With page 1 of the Communiquarium Newsletter still displayed, scroll up, and then click the masthead text box.
2. Click the Spelling button on the Standard toolbar to start the spell checking process.
3. Click the Ignore button to ignore the name of the newsletter.
4. If Publisher displays a dialog box asking if you want to check the rest of the publication, click the Yes button.
5. Click the word, proud, in the list to choose the correct spelling of the flagged word and to transfer it to the Change to box.
6. Click the Change button to change the word, proud to proud.
7. If you have other errors, choose the appropriate measure to fix or ignore them.
8. Click OK in the Microsoft Publisher dialog box to close the box because the spelling check is complete.

Checking the Newsletter for Design Errors
You are now ready to check the newsletter for design errors as you did in Publisher Project 1. The Design Checker can check single pages or entire publications for a specific type of error or all types of errors. The Design Checker looks for errors related to design issues and object interaction, providing comments and correction choices. Design errors are the most common type of problem when submitting a publication to a professional printer. Some of the errors flagged by the Design Checker include:

- Empty frames
- Covered objects
- Text in overflow area
- Objects in nonprinting region
- Disproportional pictures
- Spacing between sentences
- Low resolution graphics

To Check the Newsletter for Design Errors
1. Click Tools on the menu bar and then click Design Checker to start the process.
2. If the Design Checker finds errors, choose to fix or ignore them as necessary. When the Design Checker terminates, close the Design Checker task pane.